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Congratulations on your purchase of Finale 2005 for Macintosh! 
 
IMPORTANT: Read this document before you begin working with Finale 2005 and print a copy of it to 
keep with your Finale information.  
 
This file contains important information about Finale 2005 not included in the User Manual as well as 
information about converting older files into the new version's format. Please note that Finale 2005 files 
cannot be opened in previous versions of Finale. 
 
This document is organized by each version's changes; those of you already familiar with earlier versions 
may wish to read only the new information. The Read Me contains the following sections: 
 

Running Finale 2005 
New features in Finale 2005a 
New features in Finale 2005 
Fixes in Finale 2005b 
Fixes in Finale 2005a 
Fixes in Finale 2005 

 
You may also visit our web site, www.finalemusic.com for updated information about Finale and 
information on new releases. 
 

Running Finale 2005 
 
System Requirements Change 
Finale 2005 for Mac requires OS X, 128MB RAM (256MB RAM recommended), and 200MB of free hard 
drive space. 
 
Adobe Acrobat Reader 
The Adobe Acrobat Reader is required to view the User Manual and the electronic version of the 
Installation and Tutorials Manual. 
 
User Manual 
For full documentation on how to run Finale 2005, see the User Manual. To access the User Manual, 
choose the Help menu, then User Manual, then Table Of Contents. 
 
Registering Finale 2005 
The first time you launch Finale, you will be prompted to register. To register a single copy of Finale, click 
Register Now! to open the Registration Wizard (or, from the Help Menu, choose Register Finale). Then 
follow the instructions to register your copy of Finale via the Internet, phone, or mail. If you choose not to 
register, you will be prompted to do so each time you launch Finale. If you do not register within thirty 
days, printing and saving are disabled until you choose to register. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given computer 
installation. Verify that the correct serial number has been entered. If you make a change to the computer 
(such as replacing the hard drive or motherboard, or install a new operating system), then you will need to 
re-authorized the installation. If you have already installed and authorized twice, you will need to contact 
Customer Service directly by phone, FAX or standard mail with your serial number and the location ID for 
the specific installation in question, and one of our representatives can clear the previous authorization 



from your account. If the software is not "reminding" you to register when you run the program, then the 
registration/authorization has been successfully completed. 
 
Save As Web Page and the Finale Viewer 
Support for the Finale Viewer browser plug-in has been discontinued in favor of Finale NotePad, which 
provides a free, reliable, and easy way to view and playback Finale documents downloaded from the 
Internet. To open a Finale (MUS) file available at Finale Showcase, or another online resource, viewers 
now need to simply download the file to their local machine and then open it in Finale NotePad. This 
paradigm shift eliminates a variety of problems associated with some web browsers, and means that all 
Finale files posted on the Internet will be available for viewing on all machines immediately upon the 
release of Finale NotePad 2005. Finale NotePad is available for download free of charge at 
www.finalemusic.com/notepad. (Note that documents saved in Finale 2005 are only compatible with 
NotePad 2005 which becomes available shortly after the Finale 2005 release. NotePad 2005 will open files 
saved in any Finale version 2005 or earlier.)  
To post a Finale document now only requires a standard Finale file. We feel that the popularity of Finale 
NotePad, in addition to its reliable nature and added functionality provides an attractive alternative to the 
Finale Viewer. To post sheet music on a web site for viewing and/or printing using a web browser, we 
recommend generating a PDF from Finale. Use Finale 2005’s Save As Audio File feature to create a 
compressed Wave file if you want to distribute playback data of a Finale document over the Internet.  
 
Dragging while holding down a metatool key on notebook computers 
Some notebook computers are set to limit trackpad mouse movement while typing. As a result, you may 
experience sluggish performance while dragging over items while holding down a metatool key. To resolve 
this, open the Preferences pane and deactivate "Ignore accidental trackpad movements."   
 
Phone Technical Support 
The phone number for MakeMusic Technical Support is (952) 937-9703. FAX# (952) 937-9760. 
 
Converting Finale 2004 (and earlier) documents into Finale 2005 documents 
Finale 2005 has a different file format than earlier versions, and converts older files to the new format when 
you open them in Finale 2005. You should be aware of the following points: 
 
Opening old documents 
Finale 2005 will open and convert older versions' documents, giving them the default title 
"UNTITLED.MUS." We recommend saving a newly converted document with a different name than the 
original file, keeping the older unconverted file as a backup. If you do want to save the file using the same 
name, choose Save As from the File menu. Finale displays the original file name, so you can click OK to 
rewrite over the old file. 
 
Running older versions of Finale 
Finale 2004 (and earlier versions) for Windows or Macintosh cannot open any Finale 2005 file, except 
Standard MIDI Files. To share Finale files, the Finale application must have the same (or later) version 
number. 
 
Finale Preferences File 
The Finale Preferences file contains many program settings, from the configuration of your tool palette to 
the display colors you select. Finale stores this file in your System Folder's Preferences folder, although it 
will look first in the same folder for a Preference file. 
 
Finale 2005 does not share the preferences file with older versions of Finale. Finale 2005 will automatically 
load the new Finale 2005 default settings upon launching Finale for the first time. If you would like to use 
preferences from an earlier Finale version of Finale, go to User/Library/Preferences and delete the File 
"Finale 2005 Preferences". (If you are moving preferences from OS 9, go to System Folder/Preferences 
folder, and copy the Finale 2004 Preferences to User/Library/Preferences). Then, rename "Finale 2004 
Preferences", "Finale 2005 Preferences".  



To use Finale's default settings at any time, simply delete the Finale 2005 Preferences file from the System 
Folder/Preferences folder. A new preferences file will be generated the next time you start Finale. 
 
Keep in mind that just as older versions of Finale cannot read the newer version's music files, older 
versions cannot read the newer version's preferences. Please note that older versions of Finale will revert to 
default preference settings each time they sense that Finale 2005 has updated the Finale Preferences file. If 
you think you'll continue to use older versions of Finale and Finale 2005 on the same computer, we 
recommend placing a copy of the Finale Preferences file in the same folder as each Finale program. 
 
New Features in Finale 2005a 
 

New System Spacing Options. You can now define extra space at the beginning and end of a system 
or region of systems. 

Repeat “Show On” settings in Document Options. You can now define Staff List information for all 
repeat markings in a document on the Repeats page of the Document Options dialog box. 

Human Playback improvements include enhanced Incorporate MIDI Data, improved rolled and 
strummed chords, trills, turns with an accidental and hairpins. HP now supports turns with double-
sharp and double-flat. HP Dictionary additions include “slargando”, “riten.”, and “rfz”. Messages can 
now be disabled program-wide. 

Batch processing FPA files is now possible with FinaleScript. 

 
New Features in Finale 2005 
 

Finale Performance Assessment. Compare a live solo performance to its written notation. Assess 
against one of Finale’s existing exercises or create your own.  

SmartMusic Accompaniment Wizard. Easily create accompaniments for use with SmartMusic.  

Easily Add SmartMusic Markers including repeats, pauses, and rehearsal markers, with this new 
option under the Edit Menu.  

Enhanced Human Playback capabilities. Combine Human Playback’s interpretation with your own 
custom MIDI data, and make additional related settings in the new Human Playback Preferences 
dialog box. Then, use the Apply Human Playback plug-in to apply Human Playback styles and 
elements to regions of your score. Human Playback now includes a new "Marching Band" style and 
support for Garritan Personal Orchestra. 

New Launch Window. Get up and running quickly with Finale’s new Launch Window. From here, 
open existing files, choose how you want to start a new one, view reference material, and even import 
scanned documents.  

Expanded Setup Wizard. Save time by starting a new document using one of Finale’s preset 
ensembles, or create your own custom ensemble.  

Improved Tuplets. Tuplet brackets now avoid collision with accidentals, articulations, and other items 
and angle appropriately according to the notation. Finale also offers greater control over the spacing of 
non-beamed tuplets.  

Updated Repeats. Apply repeats to a region of your score using keystrokes and contextual menus; 
playback is set for you automatically. You can now also assign staff lists to endings and text repeats.  

Record Continuous Data. You can now record pitch bend, sustain pedal, and other continuous data 
controllers in real-time using HyperScribe.  



Simple Entry Improvements. Toggle enharmonic spelling, add expressions, and flip ties while 
entering with Simple Entry.  

FinaleScript Plug-in Improvements. Now, call any plug-in or menu item from the FinaleScript 
palette. New commands include “apply staff style”, “clear staff style”, “title”, “composer”, 
“copyright”, and more. 

Save as MP3. You can now save audio files in compressed MP3 format.  

Marching Percussion Sounds have been added to SmartMusic SoftSynth playback.  

New TGTools Plug-ins. Customize rest appearance, divide voices from one staff into two parts, and 
generate logical split points with these new plug-ins: Modify Rests, Process Extracted Parts, and Smart 
Split Point.  

3rd Party Sound Font Support. Specify your favorite sound font for playback or audio output.  

Improved Grace Note Spacing. Spacing of consecutive grace notes has been improved. See Grace 
Notes.  

Additional Spacing Controls. Specify before and after barline spacing by measure in the Measure 
Attributes dialog box. Control spacing between the clef, key signature, and time signature in Document 
Options-Clefs and Document Options-Key Signatures.  

Copy Staff Lists. You can now accurately copy measure expressions, repeat text and repeat ending 
brackets assigned to staff lists from one document to another without manually creating the staff lists 
in the destination document.  

Easily Change the Path for Graphics. Now, you can manually update the path for referenced 
graphics you have placed in the score (instead of moving or replacing the graphic).  

New Navigation Keystrokes. Now, you can press Ctrl-= to zoom in or Ctrl--(minus) to zoom out.    

 
Fixes in Finale 2005b 
 
Edit Menu 
• The Beginning Rehearsal Mark setting is not retained while switching to some pages of the Edit 

SmartMusic Markers dialog box. 
• A Wait For Note markers can now only be added to notes (not rests) in the Add SmartMusic Markers 

dialog box. 
• The Repeat End marker for the first set of Repeats is now appears when you have back to back simple 

repeats without repeat endings. 
• “Play Only on Pass” is now checked with a value of 1 by default for Repeat Ending markers. 
• Grace Notes in SMP files no longer display in the Wait For Note dialog box in Add SmartMusic 

Markers.  
• Wait for Note SmartMusic Markers are now placed correctly on the first bar if there is a pickup 

measure. 
 
Measure Tool 
• In Finale 2005a, while inserting measures into some files converted from an earlier version, a message 

no longer appears that indicates the file is damaged.  
 
Playback 
• Human Playback: Sixteenth note tuplet percussion (e.g. snare drum) rolls delineated by a roll 

articulation no longer stutter during playback at fast tempos with some Human Playback styles. 
• Human Playback: Notes with decrescendo hairpins (>) no longer increase in volume suddenly just 

prior to release. 
• Human Playback: Playback no longer stumbles when it encounters fast notes with hairpins. 
 



 
Fixes in Finale 2005a 
 
Edit Menu 
• Add SmartMusic Markers: Wait for Note markers placed in the middle of a measure now translate 

properly to SmartMusic. 
• Performance Assessment Wizard and SmartMusic Accompaniment Wizard are now in the correct 

order.  
 
File Menu 
• Scrolling through Tips in the Launch Window no longer crashes Finale if the Tips.txt file is not in the 

Finale/Component Files folder.  
• Performance Assessment Wizard and SmartMusic Accompaniment Wizard are now in the correct 

order.  
 
Finale Performance Assessment 
• If an FPA file is saved as an MUS file (in order to open the file later to fix inconsistencies for 

example), it can now be reopened and saved as an FPA file.  
• When opening an existing MIDI Keyboard file that has no conflicts, the FPA Compatibility Checker 

no longer incorrectly reports conflicts, such as "Max one staff allowed" and "More than one 
simultaneous pitch" (which are allowed for keyboard files.) 

• The “Enable” pop-up menu in the open dialog via the FPA Wizard now includes “Finale Performance 
Assessment File” 

• FPA files can no longer be saved with illegal elements if the FPA.dll is not in the Finale/Component 
Files Folder.  

• Double-clicking a page-attached ossia entry in the Assessment File Compatibility window now brings 
the offending item into view. 

 
Mass Mover Tool 
• Copying an expression to the clipboard now preserves its “This Staff Only” assignment. 
• It is now possible to revert a group of tuplets to their default settings. You can now do so for a selected 

region using the Reset button in the Change Tuplets dialog box. 
 
Measure Tool 
• Inserting a measure after manually placing a page break no longer removes the page break. 
 
Options Menu 
• The options “Gutter for Accidentals” and “Gutter for Ties” options on the Notes and Rests page of 

Document Options now function properly. 
• The word “definition” is no longer wasting space in the subsection headings of the Tuplet page of 

Document Options. 
• Document Options can be called via keyboard shortcut multiple times (without dismissal). If this is 

done and the user closes all but the original dialog, then selects “Fonts,” Finale no longer crashes. 
• A non-logical number no longer appear in the Maximum Space Between Hyphens field on the Lyrics 

Page of Document Options if a number greater than 113 is entered. 
• Manual changes to the Shape setting on the Tuplets page of Document Options are now retained after 

re-opening Document Options-Tuplets. 
• A manual update is no longer necessary to see changes to the Hidden Text Shading percent reflected in 

the score (Program Options – View). 
 
Other 
• In FinaleScript, the following options can now be copied via the Import Document Options command: 

Default Placement drop-down, Engraver Tuplets check box, and Appearance radio buttons.   
 
Playback 



• Problems using Human Playback in multi-user mode of OS X have been resolved. 
• Human Playback no longer applies undesired volume data when it is applied to a single effect that lasts 

for a large number of measures. 
 
Plug-ins 
• FinaleScript: All tuplet document options are now copied via the Import Document Options command. 
• FinaleScript: Insert Measure under the Measure Menu can now be executed. 
• FinaleScript: Vertical adjustments to dots and horizontal adjustments to upstem flags in Document 

Options – Flags are now recognized.  
• FinaleScript: Specifying the path for plug-ins and menu items now functions properly. 
• FinaleScript: Commands “lock/unlock systems” and  “import page format for parts” now function 

properly.   
• Modify Rests: The options under the Split Rests tab now function properly. 
• Text Search and Replace: It is now possible to uncheck the “Staff Style Names” and “Repeat Texts” 

text boxes. 
•  
 
Repeat Tool 
• After selecting an item from a drop-down menu in any of the Repeat dialogs, the corresponding text 

field (if there is one) now becomes highlighted, ready for typing input. 
• The context menu for the Back Repeat Bar (without the Ending Bracket) no longer contains items that 

pertain only to a Bracket. (Align Brackets, Rerset Bracket Position, and Allow Individual Positioning 
have been removed). 

• Align Brackets and Reset Bracket Positioning are now disabled in the context menu for regional 
selection if there are no brackets to be manipulated. 

• "Allow Individual Positioning" is now grayed out in the Back Repeat Bar context menu when there is 
no Ending Bracket. 

• The Relative jump setting in some older files are now converted correctly when opened. 
• In the Text Repeat Assignment dialog box, selecting "Never Jump (Mark)" or "Stop on Pass_" now 

also grays out the "Auto-Update Target" checkbox. 
• If there is a Text Repeat set up to "Play Section_Times" and a Repeat marking later in the score causes 

Playback to make another pass at the repeated section, an infinite loop no longer results. 
• Maximum Repeat Passes now prohibits an infinite loop in the following situation: When a repeat 

marking has a target of an earlier measure, and the repeat is set to Jump if Ignoring Repeats, and 
Ignore Repeats is checked. 

• In a Repeat Ending that is one or two measures long, using a Target of "Forward 2 Measures" no 
longer causes an infinite loop. 

• Status bar text no longer incorrectly states that a single click on a measure will allow you to define a 
repeat. (A double-click is required, which is now indicated in the status bar).   

 
Setup Wizard 
• When a whole note is used for a tempo marking, it is now adjusted to sit in line with the rest of the 

expression. 
 
Staff Tool 
• When you turn independent Time signature on then off for a staff, you it is now possible to change the 

Time Signature. 
• When you apply Slash notation to an area with Engraver Tuplets, the brackets and numbers are no 

longer displayed. 
• When you turn independent Time signature on then off for a staff, you it is now possible to change the 

Time Signature. 
 
Tuplet Tool 
• The X:Yq or Xq:Yq format with a broken slur shape no longer makes the last slur part go in the wrong 

direction for short tuplets. 



• When using Center Number Using Duration and the Stem/Beam Side setting, the number is no longer 
too far to the right. 

• Using the F (or ctrl-F) keystroke to flip a tuplet with Avoid Staff unchecked now functions properly.  
• The “Slope” command has been renamed “Manual Slope Adjustment” to better describe its function. 
• If "Avoid Staff" is checked, dragging the second diamond handle on a tuplet bracket toward the staff 

(so that the bracket starts to become flattened) no longer causes the tuplet number to move in the 
opposite direction. 

• Secondary/diamond hook handles are now positioned correctly for Engraver tuplets whose brackets 
would have otherwise (with Engraver Tuplets unchecked) been positioned on the other side of the 
staff. 

• Engraver Tuplet numbers no longer avoid Expressions with undesirable results. 
• With Center Number Using Duration checked, the tuplet number can now be moved horizontally. 
• The vertical position of the number relative to the bracket in Engraver tuplets no longer varies greatly 

depending on the context. 
• Nested Tuplets with Center Number Using Duration now properly align. 

 
 

Fixes in Finale 2005 
 
Compile PostScript 
• Unchecking “Additional PostScript Infomation”  no longer invokes the Additional PostScript Information dialog 

box. 
 
Expression Tool 
• You can now control the amount hidden text is shaded (Program Options-View). 
 
File Menu 
• When a SmartMusic Accompaniment is saved, and full ensemble is selected in the SmartMusic 

Accompaniment Options, staff name is used (instead of the instrument name. 
• If a repeat uses measure 1 as its target, an exported .SMP file will no longer playback an extra empty 

measure on the second pass (in SmartMusic). 
• Chord libraries now contain learned chords. 
• Finale will no longer crash using an OS 10.3 programmed keyboard shortcut for New > Document From 

Template. 
 
Graphics Tool 
• Picts no longer use the wrong file icon and open in simple text. They now open in Preview. 
• When exporting pages as either TIFF & PICT, if you sent the resolution for Other, then insert a number of zero, 

decimal, negative, or set it to be blank, Finale no longer crashes. 
• When exporting EPS graphics, the last folder used is now remembered. 
• Exporting an EPS file in OS X on a system that does not have the Classic Environment installed no longer crashes 

Finale. 
 
HyperScribe Tool 
• Using the sustain pedal as a tap source now works with non-binary keyboard sustain pedals. 
• The settings in the Tap window of the HyperScribe menu are now sticking when you go back to it. 
 
Lyric Tool 
• The two menu items “Update Hyphens” and “Update Word Extensions” have been combined into a 

single menu item “Update Smart Word Extensions and Hyphens” (under the Edit Menu).  
• Lyrics now retain line breaks and do not contain extra spaces added after hyphens when copied (with 

the Mass Edit Ctrl-C/Ctrl-V method). 
 
Mass Edit Tool 
• The dialog box name for “Change Tuplet” is now be plural. 
• Manual spacing of grace notes is no longer lost if music spacing is applied (due to new Document 



Options-Music Spacing parameters). 
• When a grace note is changed back to a "normal" note, unwanted music spacing elements no longer 

remain. 
• Settings made to "Grace Note Spacing" are no longer overwritten when music spacing is applied. 
• Note spacing now makes room for grace notes placed at the end of a measure. Beat spacing leaves 

room for them and spaces them individually. 
 
Measure Tool 
• The three contextual menus for measure handles have been combined into one menu and used for all 

three handles. 
• The contextual menu item “Break a Multimeasure Rest” has been renamed “Remove Multimeasure 

Rest” to better reflect its functionality. 
 
Options Menu 
• Accidental spacing on grace notes when both the grace note and its parent note have accidentals is no 

longer incorrect when "Use Cross-Layer Accidental Positioning" is checked in Document Options-
Accidentals. 

 
Other 
• Shift-arrow keys to highlight to the end/beginning of the piece (etc.) now works in all tools that offer 

regional selection. 
• The name of the format “Coda Notation File” has been renamed “Finale Notation File”. 
• The ability to scroll while a dialog box is visible has been removed and can no longer cause a crash. 
 
Playback 
• Finale now plays back documents containing repeats that are defined to loop infinitely (See 

“Maximum Repeat Passes” in Document Options-Repeats). 
• Spacebar-click playback no longer causes erratic playback when SoftSynth is chosen as the Output 

device in the MIDI Setup dialog box. 
• Patches 53, 54, and 55 (choir patches) are no longer too soft. 
• Patch 54 (Voice Oohs) no longer has a click sound on release of short notes. 
• The Fretless Bass patch in SmartMusic SoftSynth is no longer distorted. 
• Note attacks are no longer inconsistent in the Alto Sax patch of SmartMusic SoftSynth. 
• With SmartMusic SoftSynth playback, accordion (and some other patches) no longer make clunking 

noises on short durations. 
 
PostScript and EPS 
• It is now possible to choose whether you want to create a transparent or non-transparent EPS file (See 

Export Pages/Export Selection dialog boxes). 
 
Printing 
• Repeat enclosures now print at the correct size. 
 
Redraw 
• Finale no longer crashes when using AppleScript to print multiple files. 
• Slurs now automatically redraw after transposing music. 
 
Repeat Tool 
• Applying a backwards repeat to a bar which has a right double barline no longer displays the repeat 

plus another barline. 
• If a text repeat has no text, the repeat will no longer display a zero. 
• There is now an indication of the metatools assigned to barlines in the Repeat Selection dialog box. 
• Up and Down arrow keys now move the selection in the Repeat Selection dialog box. 
• Clicking the Reset button in the Repeat Endings dialog now resets the values back to those used in the 

Default Document. 
• Backwards repeat bars are no longer positioned beside normal measure barlines, making the thick lines 



in the backwards repeat bars wider than they should be. 
 
Setup Wizard 
• The numbers are no longer too small and the = sign too high in the Jazz font metronome marking 

added with the Setup Wizard. 
• “Simplify Key” is now unchecked in Staff Transpositions for instruments set to Up Octave and Down 

Octave. 
• Setup Wizard created tempo markings are now fixed size. 
 
Simple Entry Tool 
• It is no longer difficult to see what's the command and what's the keystroke in the Keyboard Shortcut dialog box. 
• The last note of the previous measure can now be modified if the display has jumped to a new page or screen. 
• The vertical position of the caret now moves back to where it was after an undo. 
• Finale no longer stops responding if the caret/selection is moved to a hidden staff. 
• After entering a note in a measure-one multimeasure rest, undoing past the multimeasure rest create, 

and then placing the simple cursor in measure one and redoing the multimeasure rest create no onger 
causes a Ctree error 0 in CTOTHERS:1443. 

 
Smart Shape Tool 
• There are now submenus in the context menus of Smart Shapes. 
• SmartShape Placement no longer changes when converting older documents with independent time 

signatures. 
• Double clicking on the document (using any Smart Shape Tool aside from Slurs and Glisses) without dragging no 

longer results in the Smart Shape and handle appearing.  
 
Staff Tool 
• When "use score colors" is unchecked from the View menu > Select Display Colors, applying a staff style to a 

measure with at least one note no longer causes the screen to draw blue. 
 
Tempo Tool 
• Changes made with the tempo tool are not exported when the file is saved as a midi file. 
 
Text Tool 
• “Placement”  has been renamed “Alignment” in the Text Menu to be consistant with the rest of Finale. 
• Character Settings, Multiple Font and Font dialog boxes now interact with the new Font Book functionality of 

10.3. 
• With multiple files open, making a text block edit in one can no longer effect others. 
 
Time Signature Tool 
• There are no longer rounding errors when using a composite time signature and using edus as the beat 

duration. 
 
Tuplet Tool 
• Tuplet handles now move from their screen position if the view % is changed via Scale View dialog while the 

primary handle is selected. 
 


